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More information

General principles
and procedures

You should know:

B No prerequirements

You will learn:

How to use computer systems safely
The basics of Windows

How to use the mouse and the keyboard
How to manage files and folders

How to use floppy disks

Key aspects of health and safety

Core module
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Computer systems

Computer systems come in all sizes, from At the back you will find a number of

mainframes that can fill a large room down to sockets and connections, most with cables

tiny hand-helds, but the most common type of plugged into them.

computer is a PC (Personal Computer) running Inside, and best left to the experts, are the

Microsoft Windows. power supply, the CD-ROM, floppy disk

The PC and hard disk drives, and the main circuit
board (the motherboard) containing the

PC systems typically have these components: main processor, the memory and other

»  Monitor or VDU (Visual Display Unit). On chips; plus a sound card, graphics card,

most desktop PCs this is similar to a TV, modem and other circuit boards.

though flat LCD screens are becoming more ~ »  Keyboard — though mainly for entering text

common. Newer monitors usually have and numbers, the keys can also be used for
17 inch screens, capable of resolutions up to controlling software, as you will see.
1600 x 1200. (The resolution is the number  »  Mouse — used for controlling the cursor on
of pixels — dots of light — that make up the screen, allowing you to select items, start
screen.) programs, draw pictures, and more.

> System unit — the box containing the ‘works". % There will also normally be speakers and a
This may acr as a base for the monitor, or printer, and possibly a scanner, attached.

stand beside it, as in the illustration, or on
the floor beneath.

On the front you should be able to see the
front panels of a floppy disk drive and a
CD-ROM drive, and two buttons — one is
the on/off button, the other the reset

button. .
System unit
| CD-ROM drive
Monitor —
| :| Floppy disk drive
= On/Off and
Speaker | _On an
C— ] Reset buttons
— & |
oong
e \ \ Speaker
Keyboard ~ _’Q\Mouse

The main components of a desktop PC system
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Introducing Windows

Windows is an operating system — and more. An St arting up
operating system handles the interaction between
the processor and the screen, memory, mouse,
disk drives, printer and other equipment. It is a
bridge between the hardware of the computer
and the applications — such as word processing or @  Turn on the PC.

spreadsheet programs. Whatever hardware you ® If the monitor has its own switch, turn it on.
are using, if it has a version of Windows, it can >
run any application written for that or for earlier
versions of Windows. (This book assumes that
you are using Windows 95, 98, Me, NT or 2000
— the differences between them are very small,
and will be pointed out where it matters.)
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Routines vary, depending upon the version of
Windows and whether or not you are on a
network, but will usually be like this.

Various messages and images will appear to
let you know that things are happening.

© If you are on a network, you will need to log
on — to enter your user name and password.

O After a few more minutes wait while the last
files are loaded and the system configured
for your use, the Desktop screen will appear.

Shortcuts Application windows Background

& My Computer
J File Edit ‘“iew Favortes Tools |\ H iE
= = — |
|2 - alen@|E=f X 2@ Millennium Edition

[ Tope
e Iopoy (4 1 3Inch Flappy [
Local Dizk
Local Dizk

Selectanitem || File Edit ‘iew Insert Fomat Help
Displays the co Dlg”‘lnl @l@;l ﬁl é{:llﬂlnl _I ‘
See also: IEentury Gothic [Baltic) J |14 J l_ilﬂ@l l__I_I _”

ehts
Windows Update ik Pl g T2 1 3 1 &1 B 1B 7 1 B 1 G A0 111 A2 1 A3 1]
etwor [ -

T

Accessones
Aldus

Documents Games 1 i tren mades — ar a rombination of the two — which affect both the
= Intermet Gaming Zone b lswitch betwreen the modes at any time.

Seftings i
Microzoft Chat

Online Services
Search Startlp ticrosoft Outlook Mewsreader

tilte:s &] PersonalWeb Server a single click. This is the Acfive
\weh Publishing ‘wizard Microsoft and some other sites offer

) i 3 at their sjtes. For example, Microsoft
Dutlook Express 1 'Windows Media Player 7 ane of dozens of sites

Help Internet Explarer

Eun...
windows Media Flayer

Log Off Mac... windows Explorer

[~
| NUM

Shut Down...
|| & < i || Sfunitied - Pairt | a1Help and Su..| ] deskion RT... | A3 My Compuie] | \ 16:22

Start menu Quick Launch toolbar  Application buttons Document  Taskbar Clock
The Desktop showing the main features. This is Windows Me, but 95, 98, NT and 2000 are very similar.
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The Desktop

Desktops vary hugely, but you should see some
or all of these items.

Shortcuts

These are icons — small images — with links to
programs, folders or Web sites. Clicking on the
icon will run the program, open the folder or
take you online. There will be some shortcuts
already on your Desktop, and you can easily add
your own.

Background

This may be a flat colour, a pattern, a picture or
a Web page. It can be changed at any time
without affecting anything else.

Application windows

When you run an application, such as Word, it is
displayed in a window. This can be set to fill the
screen or to take a smaller area (see page 5).

Taskbar

This is normally along the bottom of the screen,
but can be moved elsewhere. It is the main
control centre for the Desktop, carrying the tools
to start and to switch between applications.

Start leads to the Start menu (see page 9).

The Quick Launch toolbar may be present. The
default tools lead to Internet Explorer, Outlook
Express and Media Player, and to the Show
Desktop utility, which shrinks all open applica-
tions out of the way so that you have a clear view
of the Desktop.

| >

Internet Explorer

Media Player

Outlook Express  Show Desktop

Links to other applications can be added if
required.

When you run an application, a button is added
to the Taskbar. Clicking on it will bring that
application to the top of your Desktop.

The Clock can also be displayed on the Taskbar.
You should find that it keeps good time — it even
adjusts itself for Daylight Saving Time!

Programs and Windows

Starting applications

Applications can be started in several ways. Here
are the three easiest:

»  Click the application’s desktop icon (if there
is one).

» Click on its name in the Start menu (see
page 9).

»  Open a document that was created by or is
normally handled by that application. The

application will start automatically so that it
can open the document.

Switching between applications

When you have several applications running, the
current one — the one that you are working on —
will be on top. If its window is less than full-
screen, then the windows of other applications
may be partially visible underneath.

To bring a window to the top, and make it the

current one:

» If you can see any part of the window, click
on it.

»  Otherwise, click on its button in the

Taskbar.
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Window modes

A window is an independent part of the screen. Ch anging the mode

It can be moved, resized, brought to the front or
overlaid by other windows. Programs are run in
windows, and documents are usually displayed in ~ buttons in the top right of the frame.
windows within their programs. You can have 10 maximize a window, click |gj.

any number of programs running or documents
open at any one time, though you can only be
working actively in one window — the one on
top.
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The display mode can be changed using the

10 minimize a window, click [g.
10 restore a window to variable size, click [gj.

When the window is maximized, the Restore
button replaces the Maximize button:

» In a maximized window [EIEIXI.

> In a restored window [=101].
The [ Close button is always present.

A window can be in three modes:
»  Maximized — filling the whole screen.
»  Restore — adjustable in size and position.

»  Minimized — a program window is reduced
to a button on the Taskbar; a document
window is reduced to its Title bar only.

Maximized In Restore mode

BY Explloring - cup

[IRERETY 5 Windo1 bmp - Paint
PO E.ih? Edit “iew Image Colorz Help )
Back Eiy i
Jﬂddress IE 7 | (e Filz ... Menu tems ... He E? Paint Help j
=] = = ] ‘I
il Fold:ars: 1 Q Show Back Forward  Optionz  ‘web Help
Ean .
To erase a large area ™
A
e 1. Inthe toolbox, click £3 to select a
E rectangular area or click €% to select a
Q 2 free-form area,
C_ 2. Draqgthe paointer to select the area you
& (] want to erase.
gyl 3. On the Edit menu, click Clear
(& P Selection.
(=] T Mote
@D g s The current backaround color will be
@ [? used to fill the cleared area. vou can
[ v L ............| choose a different background color by
AR |pkern !J right-clicking a colar in the color box,
Ho = L e =
[ E | For Help. click Help Topics on the Help Mer| | 4|hmp J
all mE | =
|1 ohject(s] selected |135KB 25 Local intranst zone

iﬂStarl”J ﬁ %‘ @ |J @Windm...l @Explorin...l Documn... ”E’Q Paint .. | 4]5 232 PM

The current window - the

Clear the desk! Click here to minimize all A
one on fop —is highlighted

windows and show an empty Desktop

Minimized - not visible except for this
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The mouse

You can’t do much in Windows until you have
learned to use the mouse. It is used for locating
the cursor, selecting from menus, highlighting,
moving and changing the size of objects, and
much more.

Most mice are built around a ball. Moving the
mouse rolls the ball inside it. The ball turns the
sensor rollers and these move the cursor. To
control the mouse effectively you need a mouse
mat or a pad of paper — mice don’t move well on

hard desktops.

They don’t work well when they get dust and
fluff inside. If you find that the cursor starts to
move jerkily and becomes harder to control, take
out the mouse ball and clean it and the rollers
with a damp cloth. Dust inside the mouse can be
removed with tweezers. You do not need to turn
off the PC or disconnect the mouse before you

do this.

A newer type of optical mouse works by bounc-
ing a light off the surface of the mouse mat. A
sensor notices differences in the image and
changes mouse movement into cursor move-
ment. An optical mouse will work on any surface
and does not have problems with dust!

Note these points, for any type of mouse:

> Ifyou are so close to the edge of the mat
that you cannot move the cursor any

further, pick up the mouse and put it back
in the middle.

> You can set up the mouse so that when the
mouse is moved faster, the cursor moves
further. Watch out for this when working
on other people’s machines.

Mouse actions

Point — move the cursor with your fingers off the
buttons.

Click — click the left button. This action will

select a file, menu item or other object.

Right-click — click the right button over an
object on screen. This will open a menu of
commands that apply to that object.

Double-click — click the left button twice in
quick succession. This will run a program,
or open a document from its icon. You can
set the gap between clicks to suit yourself.

Drag — keep the left button down while moving
the mouse. Used for resizing, drawing and
similar jobs.

Drag and drop — drag an object and release the
left button when it is in the right place.
Used for moving objects.

Tip!

If you need to practise using the mouse,
play the games that come with Windows
— you will find them in the Accessories >
Games menu. Develop your point and
click skills with Minesweeper, and your
drag-and-drop skills with the card games.
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The keyboard

Most Windows tasks can be handled by the
mouse alone, leaving the keyboard for data entry.
However, if you prefer typing to using the mouse,
you can do most jobs with the keys. The relevant
ones are covered here.

The function keys

These can be used in some applications to run
certain operations — but they vary greatly, and so
you have to learn the keystrokes. Two have the
same effects in any application:

[F1] starts the Help system.

[F4] press this, while holding down [Alt], to
close the application.

The control sets

The Arrow keys can often be used instead of the
mouse for moving the cursor. Above them are
more movement keys, which will let you jump
around in text. [Insert] and [Delete] are also
here.

[Esc] is used to cancel operations and escape
from trouble.

A typical PC keyboard
Caps Lock

Backspace

Escape
Tab

Function keys
Enter

[Tab] moves across the page in word processing,
or between objects in other displays — the
current, selected object will be highlighted.
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[Caps Lock] can be turned on if you want to
type a lot of capitals. The Caps Lock light
shows if it is on.

[Num Lock] should be turned on to use the
number pad to type numbers, or off to use
the keys for movement. The Num Lock
light shows if it is on.

[Shift] is used to obtain capitals and the symbols
on the top-row number keys.

[Control] is used with other keys to give key-
stroke alternatives to mouse commands.

is the same as clicking Slaltl.

[Alt] is used, like [Cerl], with other keys.

[Backspace] deletes the character to the left of
the text cursor or any selected objects.

[Enter] is used at the end of a piece of text or to
start an operation.

[Delete] deletes the character to the right of the
text cursor or any selected objects.

[Insert] switches between Insert and Overtype
modes in most word processors.

Insert Lock indicators

Delete / Movement

\\ EFIEE) EIEF

Scrn
anK

it
cree |

+
Etiter
A [an Iﬂ |
Alt Shift Enter
Start Cirl Arrows Number pad

Control Shift

Num Lock

© Cambridge University Press

www.cambridge.org



http://www.cambridge.org/0521532930
http://www.cambridge.org
http://www.cambridge.org

Cambridge University Press
978-0-521-53293-8 - Career Award Information and Communications Technology: Foundation Level

P. K. McBride
Excerpt

More information

Menus

Menus give you easy access to sets of commands
and options.

There are three types of menus:

»  All programs have a menu bar, containing all
of the program’s commands and options. To
open a menu, click on it, or press [Alt] and
the underlined letter — usually the initial —
e.g. press [Alt] and [F] for the File menu.

»  For many objects on screen, e.g. icons,
blocks of text or drawn figures, you can
open a shortcut or context menu, containing
a set of commands and options that may be
used with that object. Right-click over an
object to do this.

»  Windows has its own special Start menu (see
page 9).
All menus are used in the same way:

> To select an item from a menu, click on it
or type its underlined letter.

> Some items are foggles. Selecting them turns
an option on or off. v’ beside the name
shows that the option is on.

>  You sometimes get a set of options, of which
only one can be selected at a time. ® beside
the name indicates the chosen option.

> P after an item shows that another menu
leads from it. Click on or point to the item
to open its menu.

» ... after an item shows that a dialog box will
open to get more information from you.

» Ifan item is ‘greyed out’ — written in grey
with a white shadow — it is not available at
that time. You may need to set other op-
tions, or select different types of objects,
before the command can be used.

A menu opened from the menu bar

Click or press [Alf]+[V]

Point fo open

oo Heb 5 sub-menu

J File  Edit | Wiew Go Favorites

Toalbars 3
v Statuz Bar

Search Ctrl+E
Favarites Chel+
Hiskary Ctrl+H
Large |cons v Folders

Small lcons
List
Dietails

Explorer Bar

as Web Page

TOggle Tip of the Day

Discuzs
RealGuide

LCustomize thiz Folder. .

Arrange |cons 3
Lirellmlcons

Dialog box

Chosen will follow

opftion

Refresh
Folder Options...

‘Greyed out’ — not
available at this time

The context menu for a file

Open Files can be opened, printed

L and deleted - amongst

Hew other things. The dividing

ety Wy lines are normally just

Send Ta » | decorative - they separate
e | fthe commands info groups

Capy of related ones.

Create Shortcut

Delete

Fename
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The Start menu

Click @AStart| to open the

Windows menu system.

E FPrograms b
Favoritez 4
@ Documents 4
I% Seftings 4
% Eind 4
@ Help

Bun...

Shut Dowr,..

From here you can run any
application on your PC, open
documents, get Help, find
files, customise your system
and close down at the end of a
session.

There are eight main options

Windows28

on the first level menu:

Programs is the main route to your applications.
All the programs on the PC should have an entry
here, either directly on the Programs menu or in
a submenu leading from it.

Favorites holds links to selected places on the
Internet.

Documents holds a list of recently used docu-
ment files. Selecting one from this list will run
the relevant application and open the file for you
to work on.

Settings is used to customise the Desktop and

other aspects of the system and to set up printers.

Find (Search in Windows Me) will find files and
folders on your computer, your network and the
Internet, and help you to find people on the
Internet.

Help is one way into the Windows Help system.

Run lets you run a named application. This is
mainly used to run the setup program to install
new software.

Shut down is the safe way to end a session on a
stand-alone PC. If you simply switch off, you
may lose work in documents that have not been
saved recently.

If you are on a network, you will also have a Log
Off option. Use this at the end of a session to
close down your part of the network and leave
the PC ready for someone else to use.

Smart menus

In Windows Me and in Office 2000, menus are
‘smart’. When they first open, they display only
the core items and those that you use regularly.
The rest are hidden, but will be shown if you
wait a few moments or if you click on the
double-arrow bar at the bottom of the menu.

If you use a program, it will be added to the
menu and become part of the displayed set in
future. If you don’t use a program for several
days, it will be dropped from the menu. As smart
menus are normally much shorter, it makes
selection simpler and faster.

= E Programs 4 @ Aoeessories '
é — @ Games 4
= @ Dacuments Y (5 Spstem stuff » )
= % . Microzsoft Waord Click for the
5 Settings L4 .
2 |3 “Windoves Explorer full menu
:’_% @ Search L4 #‘
5o e
=B At first the menu only
Bun... .
shows the items that
& Log Off Mac... have been used
recently.
§ Shut Down...

@ Accessones

(3

[ Games 4

@ Internet Tools L4

The full menu can be (3 Microsoft Office >
opened to reach the [ statlp >
less-used programs, if [ System stuff »

E Intermet Explaorer
Microzoft word
¥ Outlook Express

needed.

@ ‘windows Explorer
.L;. E Prograrns 4 Vi
=
E @ Documentz  #
IE % Settings L4
.r_‘% @ Search L4
= [ TS Smart menus in
) . .
= Aun.. action - it takes
a few days for
& LogOfimac.. | them fo learn
our use of
E 1 Shut Down... y
programs.
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Toolbars

A toolbar is a set of buttons that give one-click
access to commands and options. Most applica-
tions have at least one toolbar, and many applica-
tions have several — each with its own set of
commands — Word, for example, has 16 toolbars.

If an application has only one toolbar, this will
usually be placed beneath the menu bar. Where
there are several, you usually have more control
over where they are placed. In Microsoft Office
applications, such as Word, the toolbars can be
fitted into the frame on any edge of the window,
or left ‘floating’ — as free-standing panels that can
be placed anywhere.

The position of toolbars can be adjusted at any
time. To move a toolbar, drag on its handle, or its
title bar, or any part which is not covered by a
button.

In most applications, toolbars can be turned on
or off through options on the View menu.

Using toolbar buttons is easy! In most cases, all
you do is click on them. Sometimes, the button
will have a little arrow to its right. Click the
arrow to open up a palette of colours or other
options and select from there, or click the button
to use the default option.

If you point to a button and wait, a ‘fooltip’

The main toolbar is
under the menu bar

Toolbar handle

/ Toolbars.doc - Microsoft W

will usually appear to tell you what it does

Click to use the default setting
Click to choose from a palette
M[=1E3

| Eie Edit Vew Insert Fomat| Tooks Table Wi
DEELgRY | g p-o
JBody Text + Times Mew Roman -~ 10 - |_|“LI u H_

uw@

il | 5

Eg-l-l 2 IR

Toolbars

! Bold(ctrl+B) A

A toolbar is a set of buttons that give one-click access to commands and options.

EEEEN
EEECHN
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applications have at least one toolbar, and many applications have several - each with itz
own set of commands - Word, for example, has 16 toolbars.

If an application has only one toolbar, this will vsually be placed beneath the menu bar.
“Where there are several, ¥ou usually have more control over where they are placed. In
Iicrosoft Office applications, such as Word, the toolbars can be fitted into the frame-n
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Toolbar title bar

Floating toolbar
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